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Section 1: Overview
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This tutorial provides step-by-step guidance for the sample pour stop beam evaluation. Enough 

details are provided that the example model with non-doubly symmetric sections can be completed 

following the instructions here. Not every feature available in MASTAN2 will be mentioned nor 

utilized in this tutorial. For further information on many of the features within MASTAN2 make use of 

other tutorials at http://www.mastan2.com/tutorial.html. 

Overview

http://www.mastan2.com/tutorial.html
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This tutorial completes the analysis of a simply supported non-doubly symmetric section in 

MASTAN2 and some of the related stress calculations. The section considered is a pour stop that is 

simply supported. The values used in this tutorial come from the Steel Deck Institute’s Technical Note 

– No. 3: Pour Stops as Beams. 

Problem Overview

Simple Supported Beam Cross Section
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Section 2: Getting Started
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MASTAN2 is an interactive graphics program that provides preprocessing, analysis, and postprocessing 

capabilities. Preprocessing options include definition of structural geometry, support conditions, applied loads, and 

element properties. The analysis routines provide the user the opportunity to perform first- or second-order elastic 

or inelastic analyses of two- or three-dimensional frames and trusses subjected to static and dynamic loads. 

Postprocessing capabilities include the interpretation of structural behavior through deformation and force 

diagrams, printed output, and facilities for plotting response curves. MASTAN2 is based on MATLAB®, a premier 

software package for numeric computing and data analysis. 

In many ways, MASTAN2 is similar to today’s commercially available software in functionality. The 

number of pre- and post-processing options, however, have been limited in order to minimize the amount of time 

needed for a user to become proficient at its use. The program’s linear and nonlinear analysis routines are based on 

the theoretical and numerical formulations presented in the text Matrix Structural Analysis, 2nd Edition, by McGuire, 

Gallagher, and Ziemian. In this regard, the reader is strongly encouraged to use this software as a tool for 

demonstration, reviewing examples, solving problems, and perhaps performing analysis and design studies. Where 

MASTAN2 has been written in modular format, the reader is also provided the opportunity to develop and 

implement additional or alternative analysis routines directly within the program. 

MATLAB is a registered trademark of The MathWorks, Inc., 3 Apple Hill Drive, Natick, MA 01760-2098.

MASTAN2 General Information



M
A

S
T
A

N
2

Two versions of MASTAN2 have been developed and may be installed. One requires you to have 

access to MATLAB and the other does not. Both versions provide the same functionality, except that 

the MATLAB version also provides the user an opportunity to develop and implement additional or 

alternative analysis routines that will directly interact with MASTAN2. Please see the Setup Guides at 

www.mastan2.com. 

Launching MASTAN2

Start Here

http://www.mastan2.com/
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In order to minimize the learning time for MASTAN2, its graphical user interface (GUI) has been 

designed using a simple and consistent two menu approach. Using a pull-down menu at the top of the 

GUI, a command is selected. Parameters are then defined in the bottom menu bar and the command is 

executed by using the Apply button.

Base Layout

Main model window

Bottom menu bar

Edit Field

Pull-down menu

Submenu

Button
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Section 3: Beam Modeling
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The pour stop is a cold-form steel cross-section. The section is subjected to a uniform lateral and 

uniform vertical load as well as a distributed torsion. The model itself will be a simply supported beam 

with the ends fixed for torsion, but free to warp. Details on the applied load are on the next page.

MASTAN2 does not assume any unit system. Models in MASTAN2 require the use of a consistent set 

of units. This tutorial will use pound and inch for the model. The later section of the tutorial that 

determines the internal stresses does include a unit conversion to show stresses in ksi.

Problem Description - Figure

Steel Properties
E=29,500 ksi
fy=33 ksi
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The pour stop is subjected to a uniform surcharge load, a pressure from the wet concrete, self-weight, 

and a linear load from similar sources due to interactions with the deck. Uniform distributed loads are 

available in MASTAN2; however, distributed torsional moments are not possible. To obtain a similar 

effect the loading will be applied via concentrated point loads and concentrated moments with many 

smaller elements along the length of the member

Problem Description - Loading

Resulting Loads
wy = 74.0 plf ↓

= 6.17 pli ↓

wz =  35.4 plf
=  2.95 pli

mx =  104.5 in-lb/ft ↻
=  8.71 in-lb/in ↻

Load Details
See SDI Tech No. 3 for 
additional information

p1 = 20 psf
p2 = 103.3 psf

wd =  0 plf ↓

Coordinates
Lower Corner = (0 in, 0 in)
C = (-2.0677 in, 1.8405 in)

S = (0.16051 in, 0.052335 in)
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The real pour stop has the rounded geometry shown on the left. The rounded segments, particularly 

at the top, could be defined by many closely spaced nodes to account for the full radius. However, this 

tutorial will use the simplified geometry shown on the right based on SDI Tech No. 3.

Problem Description – Cross Section
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1) Start with a new, empty model. 

2) From the Geometry menu select Define Node.

3) At the bottom menu bar, click in the edit box to the right of x = and enter 0. Click in the edit box to 

the right of y = and enter 0. Click in the edit box to the right of z = and enter 0.

4) Click on the Apply Button.

5) From the Geometry menu select Extrude Element.

6) At the bottom menu bar, click on Node 1 to populate the list of nodes. Click in the edit box to the 

right of Delta x = and change 0 to 2. 

7) Repeatedly click the > button to the right of Times = to increase 1 to 24. 

8) Click on the Apply Button.

Clicking the             icon will advance the tutorial to a page that provides an image of the MASTAN2 

interface after the corresponding step is executed. Clicking the          icon on that page will return you 

to the step-by-step instructions.

Geometry Definition
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Note: At first launch you should see MASTAN2 version 
information in bottom bar. This screenshot is from 
a new model after MASTAN2 was already open.
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1) From the View menu select Defined Views and submenu option Isometric: x-y-z.

2) Now with the main member defined, continue to use Extrude Element to illustrate cross section.

3) At the bottom menu bar, click on node 13 to populate the list of nodes. Click in the edit box to the 

right of Delta y = and change 0 to -1.8405. Click in the edit box to the right of Delta z = and change 

0 to 2.0677.

4) Click on the Apply Button to define an element connecting the centroid to the lower corner of the 

pour stop cross section which was labeled N2 in the previous cross-section definition.

5) At the bottom menu bar, click on Node 26 to populate the list of nodes. Click in the edit box to the 

right of Delta z = and change 0 to -8. Click on the Apply Button.

Note: If there was another position along the bottom flat where the deflection was of interest, 2 

elements could be extruded by altering the process to extrude twice in the z direction with the 

appropriate Delta z values or by subdividing the bottom element and then moving the new node to 

the appropriate location.

Cross Section Visualization
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1) Continue defining the cross section by clicking on Node 26 to populate the list of nodes. Click in the 

edit box to the right of Delta y = and change 0 to 6.6862. Click on the Apply Button.

2) Click on Node 28 to populate the list of nodes. Click in the edit box to the right of Delta y = and 

change 0 to 0.2092. Click in the edit box to the right of Delta z = and change 0 to -0.2092. Click on 

the Apply Button.

3) Click on Node 29 to populate the list of nodes. Click in the edit box to the right of Delta y = and 

change 0 to -0.0613. Click in the edit box to the right of Delta z = and change 0 to -0.1479. Click on 

the Apply Button.

4) Click on Node 30 to populate the list of nodes. Click in the edit box to the right of Delta y = and 

change 0 to -0.3535. Click in the edit box to the right of Delta z = and change 0 to -0.3535. Click on 

the Apply Button.

Note: For the area where nodes are close together, from the View menu select Zoom Box to be able 

to zoom in and easier identify which node you are clicking.

Cross Section Visualization Finish
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1) From the Properties menu select Define Section.

2) At the bottom menu bar, click on the pop-up menu on the far right that currently displays Basic. 

Click on Advanced.

3) Click on MSASect.

4) After the interface loads, click on General to select the radio button next to it.

5) Click Next to open the editable dialog boxes. 

6) Click the edit box to the right of ID: and enter 1. Click the edit box to the right of Z-Coor.= and 

enter -8. Click the edit box to the right of Y-Coor.= and enter 0. Click Add to save the node.

7) Repeat entering the values below for each node clicking Add after each one.

Creating Section Properties

ID: 2 3 4 5 6

Z-Coor.= 0 0 -0.2092 -0.3571 -0.7107

Y-Coor.= 0 6.6862 6.8954 6.8341 6.4806
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1) Under the segments section, click the edit box to the right of ID: and enter 1. Click the edit box to 

the right of Start Node= and enter 1. Click the edit box to the right of End Node= and enter 2. Click 

the edit box to the right of Thickness= and enter 0.1046. Click Add to save the segment.

2) Repeat entering the values for each segment updating the ID:, Start Node=, and End Node= values 

by adding 1 to each number until all 5 segments are entered. Click Add after each to save.

3) Click Calculate to determine the properties.

4) Click edit box to right of Name: and enter Pour Stop.

5) Click Export to MASTAN2 to copy values to main program. Then click Close to return.

6) Click Apply to save Section 1.

Creating Section Properties – Cont.
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1) From the Properties menu select Attach Section.

2) At the bottom menu bar, use the buttons to the right of Element(s): to make the list of elements.

3) Create a list of the elements by clicking the All button. 

4) Click on the Apply button to assign Section 1. 

Section Properties - Assigning
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1) From the Properties menu select Define Material.

2) At the bottom menu bar, click in the edit box just to the right of E= and change the 0 to 29500000

(not 29,500,000). Similarly, click in the edit box just to the right of Fy= and change the inf to 33000. 

Next, click in the edit box to the right of Name: and type Steel. 

3) Click on the Apply button to save Material #1.

4) From the Properties menu select Attach Material.

5) At the bottom menu bar, create the list of elements to be assigned the properties of Material 1 by 

clicking on the All button to the right of Elements:. Click on the Apply button. 

Since the self-weight is already included in the loading summary, a self-weight was left as zero. If the 

self-weight was to be included through MASTAN2, a second weightless material would need to be 

defined and assigned to the members that are being used to visualize the cross section.

Material Properties
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1) From the Conditions menu select Define Fixities.

2) At the bottom menu bar, define a pin support with torsion fixed support by clicking in the check 

boxes just to the left of X-disp, Y-disp, Z-disp, and X-rot.

3) Create the list of nodes to be assigned this fixity by clicking on node 1.

4) Click on the Apply button.

5) At the bottom menu bar, define a roller support with torsion fixed support by clicking in the check 

boxes just to the left of X-disp to release it and leave Y-disp, Z-disp, and X-rot constrained.

6) Click Clr to empty the list of nodes. 

7) Create the list of noes to be assigned this fixity by clicking on node 25. 

8) Click on the Apply button.

Support Conditions
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1) From the Geometry menu select Define Connections and submenu option Torsion.

2) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Continuous. Repeat this for the Warping Restraint for Node j. 

3) Click the Adv button to open pop-up menu. Click the check box next to the X-axis option. 

4) Create the list of elements to be assigned continuous warping by clicking on the Add button to the 

advanced menu. Then click on the Apply button. 

5) Click Clr to empty the list of elements. Click on the left most element of the beam. 

6) Click on the menu to the right of Warping Restraint for Node i and set the value to Free. Node j is 

set from the previous step. Click on the Apply button. 

7) Click Clr to empty the list of elements. Click on the right most element of the beam. This might 

require you to click Adv to close the pop-up menu.

8) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Free.

9) Click on the Apply button. 

Adding Warping Effects
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1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, click in the edit box just to the right of PY = and change 0 to -12.34. Click 

in the edit box just to the right of PZ = and change 0 to 5.9.

3) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

4) Click Add to add all main beam nodes.

5) Click on the Apply button. 

6) From the Conditions menu select Define Moments.

7) At the bottom menu bar, click in the edit box just to the right of Mx = and change 0 to -17.42. 

8) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

9) Click Add to add all main beam nodes.

10)Click on the Apply button. 

Loading
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These steps are technically optional as you can complete analysis without saving or applying a title; 

however, this is a good time to complete this.

1) From the File menu select Define title. At the bottom menu bar, click in the edit box to the right of 

Title: and type in a brief description of this effort. This text might include the model title, your 

name, and/or the assignment number. Click on the Apply button.

2) From the File menu select Save As … . After selecting your destination folder, type in the filename 

Pour_Stop and click Save. Note that the top of the window has now changed to include the file 

name and directory as well as the time the file was last saved.

Naming and Saving
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1) From the Analysis menu select Static and submenu option 1st-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click on the Apply button.

6) From the Results menu select Node Displacements.

7) On the undeflected shape, click on the midspan node of interest, node 13, and the displacements 

for base 6 degree of freedoms are provided in the bottom menu bar. 

Results:

8) Clicking on any of the additional nodes representing the cross section will cause the displacements 

at that location due the combined effects of rotation and translation to be displayed. These 

deflections do not account for any local axial displacement due to warping though.

First-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

~0 -0.08033 -0.0598 -0.03472 ~0 ~0
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click on the Apply button.

6) From the Results menu select Node Displacements.

7) On the undeflected shape, click on the midspan node of interest, node 13, and the displacements 

for base 6 degree of freedoms are provided in the bottom menu bar. 

Results:

The values are similar to the 1st-order results but capture the change in the applied torsion that exists 

in the deformed condition. The analysis does not account for any change in the direction the load 

would be applied. The applied loads will remain in the initial orientation. 

Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-2.992e-4 -0.08758 -0.06218 -0.03726 ~0 ~0



M
A

S
T
A

N
2



M
A

S
T
A

N
2



M
A

S
T
A

N
2



M
A

S
T
A

N
2

M
A

S
T
A

N
2

Section 4: Results and Stresses
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The next section of this tutorial will provide instructions on how it is possible to calculate the internal 

stresses from the MASTAN2 output information.  After showing how to locate the necessary 

information from within MASTAN2, the next few pages will provide background and the sign 

conventions that are used with MASTAN2 to calculate the internal stresses. Some information is 

provided on how this information can be calculated. Finally, the resulting stresses at midspan are 

identified using the 2nd-order analysis internal forces.

Notes:

The internal forces taken from MASTAN2 are presented with the sign convention shown on the 

following page. Also included are the required transformations to get to a principal orientation.

The stress calculations will account for this information.

Using Internal Forces
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Sign Conventions

𝑉𝑣
𝑉𝑤

=
𝑐𝑜𝑠𝜙 𝑠𝑖𝑛𝜙
−𝑠𝑖𝑛𝜙 𝑐𝑜𝑠𝜙

∙
𝑉𝑦
𝑉𝑧

𝑀𝑣

𝑀𝑤
=

𝑐𝑜𝑠𝜙 −𝑠𝑖𝑛𝜙
𝑠𝑖𝑛𝜙 𝑐𝑜𝑠𝜙

∙
𝑀𝑦

𝑀𝑧

𝑣𝑠
𝑤𝑠

=
𝑐𝑜𝑠𝜙 𝑠𝑖𝑛𝜙
−𝑠𝑖𝑛𝜙 𝑐𝑜𝑠𝜙

∙
𝑦𝑠
𝑧𝑠
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1) From the Results menu select Element Forces.

2) On the undeflected shape, click on the element of interest, element 13, and the internal forces are 

provided in the bottom menu bar. These are the forces at the start of the member and the middle of 

the beam. 

3) These forces will be used to calculate the stresses at the middle of the beam.

4) At the bottom menu bar, drag the slider in the left-hand corner until the position indicator located 

to the right displays 1.00L. 

5) Click on the Apply button. These are the forces at the end of the member. 

6) From this position, the bimoment is required to appropriately divide the longitudinal moment into 

the standard twisting and warping components for stress calculations.

7) Repeat steps 2 through 5 for element 1 to obtain the end forces to calculate the controlling shear 

location.

Forces at the start of element 1 Forces at the end of element 1

Getting Internal Forces
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The internal normal stresses can be calculated in the geometric orientation by

This relationship simplifies when working in the principal orientation to 

Normal Stresses

𝜎𝑥 =
𝑃

𝐴
−

𝑀𝑦𝐼𝑦𝑧 +𝑀𝑧𝐼𝑦𝑦 𝑦 + (𝑀𝑦𝐼𝑧𝑧 +𝑀𝑧𝐼𝑦𝑧)𝑧

𝐼𝑦𝑦𝐼𝑧𝑧 − 𝐼𝑦𝑧
2 +

𝐵𝜔𝑛

𝐶𝜔

𝜎𝑥 =
𝑃

𝐴
−
𝑀𝑤𝑣

𝐼𝑤𝑤
−
𝑀𝑣𝑤

𝐼𝑣𝑣
+
𝐵𝜔𝑛

𝐶𝜔
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As part of calculating the shear stresses, the torsional moment must be separated into the component 

from twisting and the component of warping. 

The maximum shear stress is the combination of the stress from transverse shear (𝜏𝑉), the change in 

bimoment (𝜏𝐵), and torsion (𝜏𝑇). The transverse and warping terms are approximately uniform across 

the thickness of the element, whereas torsion linearly varies across the thickness with the extreme 

value at the surface. 

Shear Stresses

𝜏𝑉 =
−𝑉𝑧𝐼𝑦𝑧 + 𝑉𝑦𝐼𝑦𝑦 ത𝑦 + (𝑉𝑧𝐼𝑧𝑧 − 𝑉𝑦𝐼𝑦𝑧) ҧ𝑧

𝐼𝑦𝑦𝐼𝑧𝑧 − 𝐼𝑦𝑧
2 𝑡

𝐴𝑠

𝜏𝑇 =
𝑇𝑇𝑡

𝐽
𝜏𝐵 = −

𝑇𝜔𝑆𝜔
𝐼𝜔

𝜏𝑉 =
𝑉𝑣 ҧ𝑣

𝐼𝑤𝑤𝑡
𝐴𝑠 +

𝑉𝑤 ഥ𝑤

𝐼𝑣𝑣𝑡
𝐴𝑠

𝑀𝑥 − 𝑧𝑠𝑉𝑦 + 𝑦𝑠𝑉𝑧 = 𝑀𝑥 −𝑤𝑠𝑉𝑣 + 𝑣𝑠𝑉𝑤 = 𝑇𝑇 − 𝑇𝜔

𝑇𝜔 =
𝑑

𝑑𝑥
𝐵 ≈

Δ𝐵

Δ𝐿
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Determining the stresses from warping, both shear stresses and normal stresses, requires the use of 

warping coefficients. The values can be calculated based on the equations show below with additional 

details in the following documents. These documents also provide additional information on the 

stresses calculated as well.

(1) AISC Design Guide 9 (Paul A. Seaburg and Charles J. Carter, 2003) 

(2) SDI Technical Note 3. (Steel Deck Institute, 2018)

𝜔𝑛𝑠 =
1

𝐴
න
0

𝑏

𝜔𝑜𝑠 𝑡 𝑑𝑠 − 𝜔𝑜𝑠

𝜔𝑜𝑠 = න
0

𝑠

𝜌0 𝑑𝑠

Different programs exist that can assist in this calculation. One alternative is to make use of CUFSM 

to calculate these values.  The values for the current section are shown here. 

Calculating Warping Constants
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Each of the items below will link to a stress distribution for the centerline. Note moments and shears 

below are in the principal orientation.

1) Axial stress from bending moment: My & Mz & Axial stress from warping: B

2) Total axial stress from P, My, Mz, & B

3) Shear stress from transverse shear: Vy & Vz & Shear stress from warping: Tω

4) Combined shear stress from Vy, Vz, & Tω & Shear stress from twisting: TT

No total combined shear stress is shown as the warping and transverse shear stress components are 

the same across the thickness of the section while the torsional component varies linearly across the 

thickness of the section with 0 stress at the centerline to ± the value shown at the extremes.

Resulting Internal Stresses
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Section 5: Additional Options
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MASTAN2 has many options of what can be done. For this tutorial, three ideas are presented. Each 

possibility is completed starting with the initial model completed to this point. To compare to each of 

the following, it is recommended to make sure you have a base version of this model saved to be able 

to start over.

1) Applying uniform loading instead of point loads for the lateral loading.

2) Adjusting the boundary conditions to consider the effects of fixed warping.

3) Updating the model to calculate the results for other lengths or check other critical geometry.

Other Possibilities
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While a distributed moment loading is not currently available in MASTAN2, it would be possible to 

use a distributed uniform load instead of point loads using the steps below.

1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, all loads should be 0.

3) Click the All button to populate the list of nodes. 

4) Click on the Apply button to remove all point loads. 

5) From the Conditions menu select Define Uniform Loads.

6) At the bottom menu bar, click on Element(s) local x’-y’-z’ to open the drop-down menu. Select 

System global X-Y-Z. 

7) Click in the edit box just to the right of Wy = and change 0 to -6.17. Click in the edit box just to the 

right of Wz = and change 0 to -2.95. Click the Adv button to open pop-up menu. Ensure the check 

box next to the X-axis option is selected. 

8) Click Add to add the main beam elements to the element list. 

9) Click on the Apply button. 

1) Uniform Loading
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the midspan node of interest, node 13, and the displacements 

for base 6 degree of freedoms are provided in the bottom menu bar. 

Results:

The values are similar to using point loads as the model was meshed adequately. If one would be 

working with less elements with a longer length, a greater variation would be expected with bending 

moment. There is not an effect of distributed torsion included.

1) Uniform Loading -- Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-2.992e-4 -0.08758 -0.06217 -0.03726 ~0 ~0
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The use of MASTAN2 allows for different boundary conditions. While the model does not need to 

have symmetric supports, for a reference solution the ends were left as pin supports with torsion 

fixed while the warping constraint was changed to fixed. 

1) From the Geometry menu select Define Connections and submenu option Torsion.

2) Click on the left most element of the beam.

3) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Fixed. Click on the menu to the right of Warping Restraint for Node j and set the value to 

Continuous. 

4) Click on the Apply button. 

5) Click Clr to empty the list of elements. Click on the right most element of the beam. This might 

require you to click Adv to close the pop-up menu.

6) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Fixed.

7) Click on the Apply button. 

2) Alternate Boundary Conditions
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) Click on the midspan node of interest, node 13, and the displacements for base 6 degree of 

freedoms are provided in the bottom menu bar. 

Results:

6) From the Results menu select Element Forces.

7) On the undeflected shape, click on the element of interest, element 13, and the internal forces are 

provided in the bottom menu bar. These are the forces at the start of the member and the middle of 

the beam. 

2) Alternate Boundary Conditions -- 2nd-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-2.684e-5 -0.02776 -0.01727 -0.01106 ~0 ~0
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A newer feature of MASTAN2 allows for the length of the model to quickly updated.

1) From the Geometry menu select Scale Node(s).

2) At the bottom menu bar, click in the edit box to the right of Cx = and change 1 to 0.5. This will scale 

the model only in the x-direction making the overall length of the beam 24 inches. 

3) Click the All button to populate the list of nodes. 

4) Click on the Apply button.

3) Updating the Geometry -- Scaling
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1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, click in the edit box just to the right of PY = and change 0 to -6.17. Click in 

the edit box just to the right of PZ = and change 0 to 2.95.

3) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

4) Click Add to add all main beam nodes.

5) Click on the Apply button. 

6) From the Conditions menu select Define Moments.

7) At the bottom menu bar, click in the edit box just to the right of Mx = and change 0 to -8.71. 

8) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

9) Click Add to add all main beam nodes.

10)Click on the Apply button.

3) Updating the Geometry – Update Loading
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) Click on the midspan node of interest, node 13, and the displacements for base 6 degree of 

freedoms are provided in the bottom menu bar. 

Results:

6) From the Results menu select Element Forces.

7) On the undeflected shape, click on the element of interest, element 13, and the internal forces are 

provided in the bottom menu bar. These are the forces at the start of the member and the middle of 

the beam. 

3) Updating the Geometry -- 2nd-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-4.818e-6 -0.007676 -0.005841 -3.356e-3 ~0 ~0
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If other critical locations for the displacement of the cross section are needed, we can duplicate the 

existing cross section that was modeled.

1) From the Geometry menu select Duplicate Element(s).

2) At the bottom menu bar, click in the edit box to the right of Delta x = and change 0 to -2. Ensure the 

check box next to Include Attributes is selected to include the property information is included.

3) Click the Adv button to open the pop-up menu. Ensure the check box next to X-axis is selected.

4) To select the illustrated cross section, click All next to the Element(s): window. Then click the 

Remove button.  

5) Repeatedly click the > button to the right of Times = to increase 1 to 5.

6) Click on the Apply button.

The analysis is not run again as the addition of these elements will not change the results. It would just 

provide more information on the displacement of the cross section. 

3) Updating the Geometry -- Additional Sections 
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This completes the tutorial.


